
 
 

Fixed It! Baseball ScoreBook Help File 
 

 
Overview 
 
Thank you for your interest in Fixed It! Baseball ScoreBook.  We hope the 
information provided in our help file will answer most of your questions about our 
product. 
 
 
In many cases you may find using the Tab and Alt keys easier and quicker than 
using a mouse or other pointing device: 
 

-  Use the Tab key to jump from one field to another. 
-  Also, whenever you see a button that has a letter underlined, you may 
use the Alt key in combination with that letter to select that button.  For 
example, the Print button may be chosen by selecting Alt-P. 

 
 

In addition, several accelerators are also available for common functions: 
 

  F1              - Help file 

  Alt-X           - Exit the program 

  Control-S       - Save the game 

  Control-W      - Make a substitution 

  Control-B       - Courtesy batter 

  Control-R      - Courtesy runner 

  Control-Alt-L   - Load game as it was last saved 

 
 

We are constantly looking for ways to improve our products.  If you have any 
questions, comments, or suggestions, feel free to e-mail us at 
support@fixedit.com . 
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Schedules 
 
Schedules can provide the user with a means to track games by Date and Time and an 
alternate means for launching games.  
 
To create a schedule file: 
  - Select Schedule from the File Menu 
  - Select New 
  - Add Games as described below 
  - Select OK 
  - Enter a file name for the schedule 
  - Select Save 
 
To edit an existing schedule file: 
  - Select Schedule from the File Menu 
  - Select Edit 
  - Choose a Schedule File and Select Open 
  - Add, Update and Delete events as desired 
  - Select OK 
 
To add a new game to a schedule: 
  - Select a Date using the Date Button 
  - Enter a Time, and Field name, and any desired Note in the fields provided 
   
  If Team files already exist: 
  - Select teams with the Home Team and Visiting Team Buttons 
 
  If Team Files do not yet exist: 
  - Type a team name in the field provided 
  - If desired, create a new team with this name by selecting the Create Button 
  - Select Add Event 
 
To add an existing game to a schedule: 
  - Select a game with the Select Game Button 
  - Select Add Event 
 
To launch a game from a schedule: 
  - Select the game from the Schedule List (Click on the date or row) 
  - Select the Start button 
 
To export a schedule: 
  - Choose the Export Button 
  - Select a file type from .csv (Spreadsheet), .htm (Web Page), or .txt (ASCII Text) 
  - Enter a file name 
  - Select the Save Button   
 
To print a summary: 
  - Choose the Print Button 
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Teams & Rosters 
 
Before you can use Baseball ScoreBook to score a game, you must first create at least 
two team files. 
 

To create a team file: 
  - Select Team from the File Menu 
  - Select New 
  - Enter a Team Name, Coach, and Manager in the fields provided 
  - Select the Edit Roster Button 
  - To add a player, enter player information in the Name, Position, Batting Order, 
 Uniform Number, Bats Right, Left, or Switch and Throws Right or Left fields, then 
 select the Add Player Button.  Repeat this for each player on the team, then select 
 the OK Button to return to the Edit Team Dialog.  As you enter players into the 
 Batting Order, the Check Boxes on the field in the lower left will indicate what fielding 
 positions are covered in the Starting Lineup.   
 
  - If you wish, you may add personal information about your team members by selecting 
 the Personal Info Button. 
  - Select the OK Button again, then enter a file name for your team. 
 

To import a team file from a .CSV file: 
- Create a file with any text editor and give the file a .csv extension.  If you’re using a 

 word processor, make sure to save the file as text. The .csv file must have the 
following format: 
         line 1:Team Name (max of 25 characters) 
         line 2: Manager, manager name, Coach, coach name 
         line 3: #,Name,Pos,BO,Bats,Throws 
         line 4..n: Player Name, Position(0..14), Batting Order(0..20),  

Uniform Number(-1..99), Bats (LH, RH, SH), Throws (LH, RH) 
 
  - Select Team from the File Menu 
  - Select Edit 
  - Select CSV Team File from the Files of Type drop down list  
  - Select a CSV file from the list provided 
  - Edit Team if necessary 
  - Enter a file name for your team 
 
CSV Team Format Example: 
 

Huntsville Hounds 

Manager,Rob Cochran,Coach,Gayle Cochran 

#,Name,Pos,BO,Bats,Throws 

99,Rob Cochran,Second,1,SH,RH 

27,Johnny Pew,Catcher,2,RH,RH 

4,Harmon Killabeer,First,3,RH,RH 

37,Joe Dicoffeo,Designated Hitter,0,RH,RH 

5,Willie Might,Short Stop,5,LH,LH 

44,Hank Errand,Left Field,6,RH,RH 

19,Crooks Robins,Third,4,RH,RH 
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33,Jose Canhito,Center Field,7,RH,RH 

7,Greg Hoe,Pitcher,8,RH,RH 

23,Ron Gnat,Right Field,9,RH,RH 

15,Jay Ringer,Extra Hitter 1,10,RH,RH 

55,Sam Soda,Extra Hitter 2,11,RH,LH 

 
LH – Left Handed, RH – Right Handed, SH – Switch Hitter 
 
Position must be one of the following: 
 
Bench, Pitcher, Catcher, First, Second, Third, Short Stop, Left Field, Center 
Field, Right Field, Short Field, Designated Hitter, Pinch Hitter, Pinch Runner, 
Extra Fielder 1, Extra Fielder 2, Extra Fielder 3, Extra Fielder 4, Extra Fielder 5, 
Extra Fielder 6, Extra Fielder 7, Extra Fielder 8, Extra Fielder 9, Extra Hitter 1, 
Extra Hitter 2, Extra Hitter 3, Extra Hitter 4, Extra Hitter 5, Extra Hitter 6, Extra 
Hitter 7, Extra Hitter 8, Extra Hitter 9 

 
To edit a team file: 
 
  - Select Team from the File Menu 
  - Select Edit 
  - Select a team from the list of *.TEM files provided 
  - Change any Team fields (Team Name, Coach, Manager, or Logo) if desired. 
  - Select the Edit Roster Button if you wish to add, delete or change any player in 
 the roster. 
- To Add a player, enter player information in the Name, Position, Batting Order, 
 and Uniform Number fields, then select the Add Player Button. 

  
 - To Remove a player from the roster, click on the player's name in the 
 Current Roster List Box, then select the Delete Button. 
 
- To Edit a player in the roster, click on the player's name in the Current Roster 
 List Box, then change the Name, Position, Batting Order, Uniform Number, Bats 
 Right, Left, or Switch and Throws Right or Left fields as desired.  For these changes 
 to take affect, either select the Update Player Button or click on any player name in 
 the Current Roster List Box. 
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Lineups 
 
Lineups can be changed in three ways: 
 
1) When creating or editing a team, a default Batting Order can be defined for any player 
in the roster.  Whenever a game is created using this team, the game will use this 
Lineup information by default.  It is not necessary to explicitly define all or any Batting 
Order information in the Team Roster, because the entire Lineup can be modified when 
creating a game.  
 
2)  When creating a game, all team information, including the Roster and Lineup can be 
changed.  Note that team changes made here, such as the Starting Pitcher, apply only 
to this game and are not saved to the Team File.  Permanent team changes, such as 
new players, should be made via the Team Dialog prior to creating a game. 
 
3)  To change the lineup during a game: 
  - Select Substitutions from the Lineup Change Menu. Note: This menu item is only 
 active while a game is in progress. 
  - Select the appropriate Team using the Tabs provided 
  - Click on the Player Drop Down List containing the name of the player to be removed. 
  - Select a substitute from the list provided.  An * denotes that the player is not currently 
 in the lineup. 
  - If a Player's Position has changed, from the Position Drop Down List, select a new 
 position for that player 
  - Repeat Substitutions and / or Position changes for as many players as necessary 
  - Select the other Team using the other Team tab and make any necessary 
 Substitutions and Position changes 
  - Select OK 
 
Courtesy Batters & Runners:  Some leagues allow courtesy batters and /or runners for 
 some fielders, leaving those fielders in the game.  To provide a Courtesy Batter or 
 Runner for a fielder during a game: 

- Select either Courtesy Batter or Courtesy Runner from the Lineup Change Menu. 
Note: These menu items are only active while a game is in progress. 

 - From the Batter or Runner Drop Down List, select a Courtesy Batter or Runner for 
   the current At Bat 

   - Select OK 
 
Removing DH:  When a team is using a designated hitter for a pitcher or any other 
player, the team may choose to place the DH in the field and no longer hit for the pitcher.  
To accomplish this: 
  - Select Substitutions from the Lineup Change Menu. 
  - Select the appropriate Team using the tabs provided 
  - Find the Player Drop Down List for the Designated Hitter.  Change this player's 
Position to whatever fielding position the old DH will be playing. 
  - Find the last Player Drop Down list.  This is the player the DH was batting for. The BO 
(Batting Order) box to the left indicates what position that fielder was playing.  Select 
Bench for that player's Position. 
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Creating Games 
 
After creating two Teams with complete Rosters, a new game can begin. 
 
To create a new game: 
  - Select Game from the Main Menu 
  - Select New for the Edit Game Information Dialog 
  - Input the game information (i.e. Date, Time, etc.) 
  - Select the Home Team Select Team Button and choose one of the Team files (.TEM) 
  - Make any necessary Home Team Roster and Starting Lineup changes by selecting 
 the Edit Roster Button 
  - Select the Visiting Team Select Team Button and choose a different Team files 
 (.TEM) 
  - Make any necessary Visiting Team Roster and Starting Lineup changes by selecting 
 theEdit Roster Button 
- Select the Start Button if you wish to begin scoring.  Otherwise select OK to save any 
 changes or select Cancel to abort changes to the Game file. 

 

Game Play 
 
Games are scored by entering data into score boxes for each At Bat during a game. 
 
Once play has begun, the scorer uses the Next At Bat and Previous At Bat Buttons to 
navigate between batters during an inning.  
 
When the batting team reaches three outs, upon confirmation, ScoreBook advances the 
game one-half inning.  It is also possible to end an inning prior to three outs by manually 
pressing the Next Inning Button. 
 
Navigating between innings can be accomplished by using the Next Inning and 
Previous Inning Buttons or by double-clicking on any existing At Bat in the main 
window. 
 
Once an inning is complete, no At Bats can be added to or deleted from it.  However, the 
information in any At Bat can be modified if needed. 
 
ScoreBook does not consider a game complete until the Stop Game Button has been 
selected, the user chooses to Save the game, and the user may then assign Winning 
and Losing Pitchers. 
 
Shareware Note:  Printing Games or Stats is not allowed in the Shareware Version. 
 
When a game is over, the user is prompted to select Winning, Losing, and Saving 
Pitchers from three drop down lists.  Because the rules for crediting pitchers with Wins, 
Losses, and Saves are subjective in nature, these decisions must be made by the scorer 
(See your league's rule book on the subject).  In addition, the user may enter the 
duration of the game and the attendance. 
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Adding / Modifying Players During Games 
 
Once a game has begun, players can be added to either team's roster.  This is 
especially useful if not all players are known before a game begins. 
 
To add a player: 
  - Select Team from the File Menu 
  - Select Edit 
  - Select a team 
  - Select the Edit Roster Button 
  - Supply a Name, Position, Uniform Number, etc. in the fields provided 
  - Select the Add Player Button (The player's Batting Order number will automatically 
     be assigned to 0.  You must use the Substitution logic to put the added player into the 
     current lineup) 
  - Select the OK Button 
  - Select the OK Button, once again 
 
A Player's attributes can also be Modified to account for data entry errors such as 
misspelling a name. These changes are applied to all offensive and defensive at bats for 
the entire game. 
 
To modify a player's attributes: 
  - Select Team from the File Menu 
  - Select Edit  
  - Select a team 
  - Select the Edit Roster Button 
  - Correct Name, Position, Uniform Number, etc. in the fields provided 
  - Select the Update Player Button (Batting Order and Position changes will be ignored.  
    You must use the Substitution logic for these changes) 
  - Select the OK Button 
  - Select the OK Button, once again 
 
 

Undo Substitutions 
 
To undo a substitution: 
  - Select Undo Substitution from the Lineup Change Menu.   
 
The Undo Substitutions dialog will display 2 list boxes with substitutions that occurred 
during the game.   The left list is a list of the Visitor subs and the right list is a list of subs 
for the Home team.    
 
  - Select a substitution to undo.  To select more than 1 substitution from a list, hold 
down the CTRL key while clicking your left mouse button.   Also, use the CTRL key in 
combination with the left mouse button to remove selections. 
 
  - Once you've selected the substitutions you want to undo, select the OK button 
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Inning Editing Features 
 
Occasionally the user may enter some data erroneously or end an inning too soon or too 
late.  Sometimes these errors may be corrected using the Move Inning Mark Forward 
and Move Inning Mark Backward functions. 
 
Moving an Inning Mark Forward will move the first At Bat in the next inning into 
the current inning.  To do this: 
  - Select an At Bat in the desired Inning 
  - Select Inning Mark from the Edit Menu 
  - Select Move Forward 
 
Moving an Inning Mark Backward will move the last At Bat in the current inning 
into the next inning.  To do this: 
  - Select an At Bat in the desired Inning 
  - Select Inning Mark from the Edit Menu 
  - Select Move Backward 
 
Additionally, it may sometimes be advantageous to Delete an Entire inning 
altogether.  To do this: 
  - Select an At Bat in an inning prior to the last inning 
  - Select Delete Last Inning from the Edit Menu 

 
 
 
 

Converting Version 2.X Games and Teams 
 
Teams and Games created using Version 2.X of Baseball ScoreBook may be used with 
Version 3.X.  Conversion only requires opening and closing each Team or Game file. 
 
To convert a 2.X Team file to 3.X format: 
 
  - Select Team from the File Menu 
  - Select Edit 
  - Select a team from the list of *.TEM files provided 
  - Select OK 
 
To convert a 2.X Game file to 3.X format: 
 
  - Select Game from the File Menu 
  - Select Edit 
  - Select a team from the list of *.GAM files provided 
  - Select OK 
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Scoring An At Bat 
 
ScoreBook uses a standardized Scoring Box to capture all the events for every At Bat 
during a game.  Each scoring box is meant to show: 
 
  - The Ball and Strike count when the runner got out or on base 
  - How the batter got on base 
      - How many runs were driven in by the batter 
      - How and how far the runner advanced while on base 
      - If the player scored or not     or 
  - How the batter got out 
      - The out number that inning 
      - The fielders involved in getting the batter / runner out 
 
ScoreBook uses a blown up image of the Scoring Box (see figure below) and the 
following buttons to capture this data: 
 

Foul  Strike  Ball 
Advance  On Base Out    

 Pickoff Att       Earned Run   Award RBI 

 

 
 
The options associated with the On Base, Out, and Advance Buttons are listed in the 
Scoring Box Section. 
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Many of the On Base and Out options for an At Bat will automatically update previous 
players still on base.  For example, if the bases are loaded and you select the On Base 
option Base on Balls, all three runners on base will automatically advance one base.  
The runner on third will score (indicated by a gray-filled diamond), and the batter will be 
given an RBI. 
 
Other options will require some minimal input.  For example, if a runner is on second and 
the current batter singles, you will be prompted to indicate which base the runner 
advanced to. 
 
RBIs are automatically awarded in most conditions; however, the scorer can use the RBI 
button to manually award an RBI to a batter or remove an unearned RBI.  See your rule 
book for an explanation on when to award RBIs.  Clicking the Award RBI Button will 
increment the RBI counter by one.  When the RBI count is four, Clicking the Award RBI 
Button again will clear all RBIs. 
 
ScoreBook also attempts to automatically determine whether a run scored is Earned or 
Unearned.  Clicking the Earned Run Button will override this assessment. 
 
The Clear Last Button will clear the last action initiated by the user for the At Bat. 
 
The Clear All Button will clear all information about the At Bat. 
 
The Pickoff Att Button allows the user to denote catcher and pitcher Pickoff Attempts. 
 
The Notes Button allows the user to associate a note to an At Bat.  These notes are 
then displayed when viewing and printing the Box Scores 
 
The scorer can check or edit Batter, Runner, Pitcher, Fielder, or Error assignments for 
any At Bat.  To do this: 
  - Select the At Bat to update by double-clicking on its Scoring Box 
  - Select the Details Button 
  - Change assignments as desired 
  - Select OK 
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Editing At Bat Details 
 
Occasionally it becomes necessary to Edit and or View the Details of an At Bat beyond 
the abilities of the ScoreBook At Bat interface.  When this becomes necessary, select 
the Details button. 
 

Fields provided: 
 

Batter - The Batter in the At Bat 
 
Runner - The Runner, which is usually the same as the Batter except when a Pinch 
Runner or Courtesy Runner is used 
 
Pitcher(s) - ScoreBook records each pitcher in an At Bat and the last action that 
each pitcher was responsible for.  The last action for each pitcher can be corrected 
via the Last Action drop-down lists.  This is especially useful when the scorer makes 
a substitution at the wrong time.  In addition, a pitcher may be added to an At Bat by 
selecting a player from the next available pitcher drop-down list. 
 
Out Pitcher - The Pitcher responsible for getting a batter or runner out.  Suppose 
Pitcher 1 is subbed after walking Batter 1.  In the next At Bat Pitcher 2 then gets 
Batter 2 to ground into a double play.  Pitcher 2 will get credit for both outs, though 
he never pitched to Batter 1.  This is necessary to ensure correct ERA calculations. 
 
Fielders - The Fielders that touched the ball during a play that resulted in an out, 
listed in the order they touched the ball.  Generally, the last fielder to touch the ball 
will be given a Put Out, while each previous fielder will be given an Assist.  The user 
can override these assignments by selecting Put Outs and Assists in the drop down 
list beside each fielder. 
 
Fielders Responsible For Errors - ScoreBook automatically records errors that 
result in a base advance, but errors may be assigned later.  As many as eight errors 
may be recorded per At Bat: four error fields reserved for errors resulting in a base 
advance; and four reserved for any Other Errors.  The user may assign an error by 
selecting one of the unused error fields and selecting a Player Name, then selecting 
an Error Type.  
 

ScoreBook also supports modifying the following information: 
  Ball In Play Hit Type, Hit and Run, Batted Ball Velocity, Count, and 
  Home Run Distance  
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Scoring Legend 
 
Each At Bat is tracked via a standardized Scoring Box.  The Scoring Box conventions 
are described below: 

 
 

Abbreviations Used: 
On Base                      Out                       Advance               

1B  - Single                 CS  - Caught Stealing      SB  - Stolen Base 

B   - Bunt                   BO  - Bunt Out             AB  - Awarded Base 

2B  - Double                 LBE - Left Base Early      WP  - Wild Pitch 

G2B - Ground Rule Double     DNT - Did Not Tag Up       PB  - Passed Ball 

3B  - Triple                 PO  - Picked Off           BK  - Balk 

HR  - Home Run               F   - Fly Out              E?  - Advance on Error 

IHR - Inside Park Home Run   Fo  - Foul Fly Out         ~E  - Previous Error 

BB  - Base on Balls          DTS - Dropped 3rd Strike,  ~WP - Previous Wild Pitch 

IW  - Intentional Walk             Out at First         ~PB - Previous Passed Ball 

HP  - Hit by Pitch           BS  - Sacrifice Bunt       ~BK - Previous Balk 

AB  - Awarded Base           SF  - Sacrifice Fly        2S  - Double Steal 

IF  - Interference           SAC – Sacrifice            3S  - Triple Steal 

FC  - Fielder's Choice       DP  - Double Play          CSE?- Caught Stealing-Error  

E?  - Reached On Error       GDP - Grounded Into DP     DI  - Defensive Indifference 

SAC-E? - Reached on Error    TP  - Triple Play          AT  - Advance on Throw 

  While Sacrificing          K   - Strike Out Swinging  IF  - Advance on Interference 

ASE-E? - Assist with Error   K (Backward)- K Looking    AWE – Assist With Error 

DTS-WP - Dropped 3rd         LBP - Left Base Path         

  Strike, Wild Pitch         LD  - Line Drive 

DTS-PB - Dropped 3rd         TBB - Touched By Own Batted Ball 

  Strike, Passed Ball        BF  - Bunt Foul on Third Strike 

SH-E? – Sac Hit with Error   MB  - Missed Base 

SF-E? – Sac Fly with Error   IBB - Illegally Batted Ball 

FC-DP – Fielder’s Choice DP  BOT - Batted Out of Turn 

                             GO  - Ground Out 

                             CO  - Called Out 

                             I   - Interference 

                             CV  - Circle Violation (Softball) 

                             LOV - Leading Off Violation (Little League) 

                             HFS - Head First Slide (Little League) 

                             IF  - Infield Fly 

                             TB  - Thrown Bat 

                             HBB - Hit By Fair Ball 

                             OR  - Over Ran Base 

                             NFD – Non-Force Double Play 

                             SFD – Sac Fly Double Play 

                             BLV – Base Line Violation 

                             P   - Popup 

? - Denotes position of the fielder responsible for error (e.g. E3 indicates an error on the First Baseman)  
 

Fielder Positions: 
 

1 Pitcher         4 Second Base 7 Left Field 10 Short Field(Softball) 
2 Catcher         5 Third Base 8 Center Field  

3  First Base 6 Shortstop 9 Right Field  
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Example Scoring Situations 
 
Scoring certain events can be tricky, especially those involving more than one offensive 
player.  ScoreBook was written to handle a wide variety of situations. 
 
Example 1:  Player 1 singles to left. 
  - At Player 1's Scoring Box itev2b, Select the On Base Button 
  - Select Single 
  - When prompted to indicate where the ball was hit, click on some area in left field 
  - Advance to the next batter's Scoring Box by selecting Next Batter 
 
Example 2:  With Player 1 on First Base, Player 2 hits into a Double Play (Shortstop to 
Second Baseman to First Baseman). 
  - At Player 2's Scoring Box, Select the Out Button 
  - Select Double Play 
  - Click on the Fielder Check Boxes in the order the fielders touched the ball, in this 
 case Short, Second, then First (Position numbers of the fielders involved appear in 
 the Fielded By: Text Box) 
  - Select OK 
  - When prompted to "indicate other player out," select Player 1 from 1st 
  - Select OK 
  - When prompted to indicate where the ball was hit, click on some area around the 
 Shortstop 
 
Example 3:  With Player 1 on First Base, Player 2 grounds to the Shortstop, who throws 
to the Second Baseman covering second.  The Second Baseman makes no attempt to 
throw to first.  
  - At Player 2's Scoring Box, Select the On Base Button 
  - Select Fielder's Choice 
  - When prompted to indicate where Player 1 went, select the Out Button 
  - Select Forced Out 
  - Click on the Fielder Check Boxes in the order the fielders touched the ball, in this 
 case Short, then Second 
  - Select OK 
 
Scoring Notes: 
Selecting Fielders for Assists and Put Outs:  When Stats are computed, in most cases 
the last fielder in the Fielder list will be credited with a Put Out and all prior fielders will 
be credited with Assists.  Exceptions are Double and Triple Plays which will award 
additional Put Outs as necessary.  When scoring unassisted Double or Triple Plays, 
when prompted to input fielders, only select the exceptional fielder once.  The fielder will 
be credited with the correct number of Put Outs.  For more information on Put Outs and 
Assists, review the Statistics Considerations section.  
 
Fielders Versus Bases:  Be careful to select fielders and not just a base.  For example, if 
a player is forced out at second base, but the Shortstop catches the ball for the put out, 
don't select the second baseman for the Put Out.
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Statistics 
 

Some stats are displayed throughout the game in the Current Pitcher and Inning Stats 
Window.  More in-depth team and individual stats, Scatter Plots, and Pitch Plots are 
available from menus. 
 
To view and print Player and Team Batting, Running, Fielding and Pitching Statistics: 
 
- Select Team and Player Stats from the Statistics Menu 
 
If a game is already open: 
  - Pick a Team 
  - Select OK 
 
If no game is open: 
  - Choose a game file (*.GAM) to be analyzed from the Files List Box 
  - Click on the Select Game Button to add this game to the Games To Analyze 
 List Box 
  - Add as many games as you like in the same manner or use the Select All Button 
 if you wish  to analyze every game in the currently selected directory 
 
Shareware Note:  Only one game at a time may be evaluated with the Shareware 
version. 
 
To remove a game from consideration: 
  - Choose the game file in the Games To Analyze List Box 
  - Click on the Remove Game Button. 
 
  - Once all games are selected, choose a team from the Team To Analyze Drop Down 
 List.  If you want to view stats for all teams, choose All Teams 
  - Select OK 
 
The Batting, Running, and Fielding Stats Window will then appear.  If the user selected 
All Teams, a single tab labeled All Teams will appear, containing stats for all players in 
all games selected.  Otherwise three tabs will appear: one for the Team Selected, one 
for Opponent stats, and one for Combined stats.  The stats for the Team Selected 
appear by default. 
 
  - Use the Batter, Runner, Fielder, and Pitcher Tabs to toggle between Batter, 
 Runner, Fielder,  and Pitcher Stats 
 
  - When Batting, Runner, and Fielder Stats is chosen, use the Vs RH Pitchers, Vs LH 
 Pitchers, and Vs All Pitchers Radio Buttons to see how batters fared versus left 
 handed, right handed, or all pitchers 
 
  - When Pitching Stats is chosen, use the Vs RH Batters, Vs LH Batters, and Vs All 
 Batters Radio Buttons to see how pitchers fared versus left handed, right handed, or 
 all batters 
 
  - Select the Print Button to print all Batter, Runner, Fielder Stats and Pitcher Stats 
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  - Select the Export Button to save the displayed data to an ASCII text file or an  
 HTML file 
 
  - Select the Edit Layout Button to customize the stats that are being viewed.   From 
 the resulting popup menu, select either Edit Batting Stats Layout or Edit Pitching 
 Stats Layout.   The resulting dialog will let you hide and enable the statistics 
 computed by ScoreBook.    You may want to do this when formatting your output prior 
 to printing or exporting. 
 
- Select the FTP Button to send the HTML output to the server defined in the 
 program's options.   From the resulting popup menu, select Send HTML Once  to 
 send the file once or select Send HTML Every XX Seconds to have ScoreBook 
 resend the file every XX seconds. 

 
Statistics Considerations: 
 
ERA - The Innings Per Game Drop Down List is provided in the Stats Dialog to allow 
correct computation of pitcher Earned Run Averages (ERA).  The default is 9 innings.  
This can be changed to 1 through 9 based on the normal innings per game in your 
league.  The method of computing ERAs is described in Pitching Stats. 
 
Errors & Fielding Average - To ensure Errors are assigned appropriately and Fielding 
Average is computed correctly, special care should be taken while scoring fielding 
errors.   
 
Example 1: 
A runner advances two bases due to a throwing error.  Advance the player using the 
Advance Button and charge an error by selecting Error and clicking the check box 
associated with the offending player.  On the second base path advance, charge a 
Previous Error.  This will ensure that the fielder is charged with only one error. 
 
Example 2: 
Two runners advance a base due to a throwing error.  Advance the first player, charging 
an error as described in example one.  Advance the second player using Previous Error.  
Again, this will ensure that the fielder is charged with only one error. 
 
Example 3: 
The third baseman handles a ball perfectly, throws to first, but the first baseman drops 
the ball.  Because the third baseman properly handled the ball, he should be credited for 
an assist, even though the batter wasn't put out.  Select the On Base Button for the 
batter and select Assist With Error.  Click the check box associated with the offending 
player, then click all the fielders who touched the ball in the order they touched it, 
including the fielder who committed the error.    
 
Wild Pitches, Balks, & Passed Balls - Care should also be taken while assigning Wild 
Pitches, Balks, and Passed Balls.  Any time a player commits a mistake that allows more 
than one base advance, that mistake should be assigned once, and all other base 
advances should be charged as Previous Wild Pitch, Previous Balk, or Previous Passed 
Ball.  This will ensure that the fielders aren't overly penalized for their sins. 
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Batting Statistics 
 
The following is a list of the currently supported Batting Stats and how they are 
computed: 
 

GP Games Played 

IP Innings Played 

PA Plate Appearances 

OAB Official At Bats = All complete plate appearances 
except when on base as a result of Base On Balls, 
Intentional Walk, Hit By Pitch, or Catcher Interference 
or out as a result of any Sacrifice 

H Hits = Number of Singles + Doubles + Triples + Home 
Runs 

1B Singles 

2B Doubles + Ground Rule Doubles 

3B Triples 

HR Home Runs + Inside Park Home Runs 

R Runs 

RBI Runs Batted In 

Avg Batting Average = Hits divided by Official At Bats 

Slug Slugging Percentage = Total Bases divided by Number 
of Official At Bats (OAB) 

OBA On Base Average = Total Times on Base (H + BB + 
HBP) divided by Total At Bats (OAB + BB + HBP + SF) 

BNT Bunts 

BNT% Successful Bunt Percentage 

On Base By 

BB Base On Balls (including Intentional Walks) 

HBP Hit By Pitch 

RE Reached On Error 

FC Fielder’s Choice 

DTSWP Dropped Third Strike – Wild Pitch 

DTSPB Dropped Third Strike – Passed Ball 

DTSE Dropped Third Strike – Error 

CATI Catcher Interference 

OFI Other Fielder Interference 

Sacrifices 

S Sacrifices (other than Sac flies and bunts) 

BS Bunt Sacrifices 

SF Sacrifice Flies 
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Out By 

SOS Strike Out Swinging 

SOL Strike Out Looking 

SO Strike Out – Total 

GO Ground Out 

FO Fly Out 

FFO Foul Fly Out 

PO Pop Out 

IFFLY Infield Fly 

INTF Interference 

TBAT Thrown Bat 

LD Line Drive 

HIDB Hit Into Double Play 

HITP Hit Into Triple Play 

TBBB Touched By Own Batted Ball 

BOTRN Batted Out of Turn 

BF2S Bunt Foul with 2 Strikes 

DTSO Drop Third Strike Out 

ILBB Illegally Batted Ball 

HBFB Hit By Fair Ball 

FRCO Forced Out 

TAGO Tagged Out 

CO Called Out 

BNTO Bunt Out 

NFGDP Non-Forced Grounded Into Double Play 

SFDB Sacrifice Fly Double Play 
 
 
The Stats can be sorted by clicking on the desired column to sort by.  Clicking that 
column again will sort the stats by that column again, but in descending order. 
 
In addition, the stats may be computed versus all pitchers, or versus either left or right 
handed pitchers. 
 
Selecting the Opponents tab will show the stats for the opponents for the games 
selected. 
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Running Statistics 
 
The following is a list of the currently supported Running Stats and how they are 
computed: 
 

R Runs Scored 

SB2 Stolen Bases – Second Base 

SB3 Stolen Bases – Third Base 

SBH Stolen Bases – Home 

SB Total Stolen Bases 

SBA Stolen Base Attempts 

SB% Stolen Base Percentage = SB divided by SBA 

CS2 Caught Stealing at Second 

CS3 Caught Stealing at Third 

CSH Caught Stealing at Home 

CSDB Caught Stealing in Double Play 

PKO1 Picked Off at First 

PKO2 Picked Off at Second 

PKO3 Picked Off at Third 

PKO Total Times Picked Off 

MB Missed Base 

LBE Left Base Early 

DNTU Did Not Tag Up 

LBP Left Base Path 

CV Circle Violation 

LOV Leading Off Violation 

BLV Base Line Violation 

HFS Head-First Slide 

OVRB Over Ran Base 
 
The Stats can be sorted by clicking on the desired column to sort by.  Clicking that 
column again will sort the stats by that column again, but in descending order. 
 
In addition, the stats may be computed versus all pitchers, or versus either left or right 
handed pitchers. 
 
Selecting the Opponents tab will show the stats for the opponents for the games 
selected. 
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Fielding Statistics 
 
The following is a list of the currently supported Fielding Stats and how they are 
computed: 
 

Pos Position 

GP Games Played 

TP Time Played = Number of Outs Played at Position divided 
by Outs Per Inning 

APO Assisted Put Outs 

UAPO Unassisted Put Outs 

PO Put Outs 

A Assists 

E Errors 

FE Fielding Errors 

TE Throwing Errors 

BE Bobbles 

Catcher / Pitcher Stats 

PKO1 Pick Offs at First Base 

PKO2 Pick Offs at Second Base 

PKO3 Pick Offs at Third Base 

PKO Total Pick Offs 

PKOA1 Pick Off Attempts at First Base 

PKOA2 Pick Off Attempts at Second Base 

PKOA3 Pick Off Attempts at Third Base 

PKOA Total Pick Off Attempts 

Catcher Stats 

PCHR Pitches Received 

PB Passed Balls 

DTSOB Dropped Third Strikes – On Base 

DTSOUT Dropped Third Strikes – Outs 

CS2 Caught Stealing Thrown Out at Second 

CS3 Caught Stealing Thrown Out at Third 

CSH Caught Stealing at Home 

CSPOH Caught Stealing Put Out at Home 

SBA Stolen Bases Against Catcher 

INTF Interference 

F% Fielding Percentage = (PO + A) divided by (PO + A + E) 

CPE Chances Per Error = (PO + A + E) divided by E 
 
 
The Stats can be sorted by clicking on the desired column to sort by.  Clicking that column 
again will sort the stats by that column again, but in descending order. 
 
In addition, the stats may be computed versus all pitchers, or versus either left or right handed 
pitchers. 
 
Selecting the Opponents tab will show the stats for the opponents for the games selected. 
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Pitcher Statistics 
 
The following is a list of the currently supported Pitching Stats and how they are 
computed: 

GS Games Started 

GC Games Completed 

SHO Shutouts 

SA Saves 

BF Batters Faced 

H Hits Allowed 

1B Singles Allowed 

2B Doubles Allowed 

3B Triples Allowed 

HR Home Runs Allowed 

R Runs Allowed 

BB Base On Balls 

HB Hit Batters 

BK Balks 

WP Wild Pitches 

SO Strike Outs 

PKO1 Pick Offs at First 

PKO2 Pick Offs at Second 

PKO3 Pick Offs at Third 

PKO Total Pick Offs 

PKOA1 Pick Offs Attempts at First  

PKOA2 Pick Offs Attempts at Second  

PKOA3 Pick Offs Attempts at Third  

PKOA Total Pick Offs Attempts 

W Wins 

L Losses 

PCT Winning Percentage 

PC Pitch Count (does not count intentional balls) 

TS Total Strikes 

TB Total Balls (does not count intentional balls) 

FPS First Pitch Strikes 

FPB First Pitch Balls 

FPS% First Pitch Strike Percentage 

IP Innings Pitched (One third inning is given for each out) 

ER Earned Runs - For ScoreBook, a run scored is always considered  

"earned" unless an error or passed ball contributed to advancing 
a batter or runner at least one base. 

ERA Earned Run Average = (ER * Innings Per Game) divided by IP 

OBA Opponent’s Batting Average 
 
The Stats can be sorted by clicking on the desired column to sort by.  Clicking that column 
again will sort the stats by that column again, but in descending order. 
 
In addition, the pitching stats may be computed versus all batters, or versus either left or right 
handed batters. 
 

Selecting the Opponents tab will show the stats for the opponents for the games selected. 
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Scatter Plots 
 
To view and print Scatter Plots: 
  - Select Scatter Plots from the Statistics Menu 
  - Choose a game file (*.GAM) to be analyzed from the Files List Box. 
  - Click on the Select Game Button to add this game to the Games To Analyze List 
 Box.  Add as many games as you like in the same manner. 
    or 
  - Click the Select All Button if you wish to analyze every game in the currently selected 
 directory. 
  - Select OK 
  - Select a batter and a pitcher from the drop down lists.  Choose ALL PITCHERS to 
 see how a particular batter performs against all pitchers.  Choose ALL BATTERS to 
 see how a particular pitcher fares against all batters. 
  - Three plots appear, a Hit plot, an Out plot, and a Combined Hit and Out Plot.  Red 
 marks indicate hits, blue marks, outs. 
  - Select the Print button to print the three plots. 
    

Pitch Plots 
 
To view and print Scatter Plots: 
  - Select Pitching Plots from the Statistics Menu 
  - Choose a game file (*.GAM) to be analyzed from the Files List Box 
  - Click on the Select Game Button to add this game to the Games To Analyze List 
 Box.  Add as many games as you like in the same manner. 
    or 
  - Click the Select All Button if you wish to analyze every game in the currently selected 
 directory 
  - Select OK 
  - Select a batter and a pitcher from the drop down lists.  Choose ALL PITCHERS to 
 see how a particular batter is pitched to by all pitchers.  Choose ALL BATTERS to 
 see how a particular pitcher pitches against all batters.  You may also choose whether 
 or not to include Balls, Strikes, or Pitches that were hit.  You may also choose to  
 include all types of pitches, or only certain types, such as Curve Balls. 
  - Two plots appear, one for left and one for right handed batters using the criteria the 
 user has chosen 
  - Select the Print button to print the two plots 
    

Current Pitcher/Inning Statistics 
 
The following is a list of stats maintained in the Pitching and Current Inning Stats 
Window throughout the game: 
 
Current Pitcher Stats: 
  - Pitch Count (does not count intentional balls) 
  - Strike Outs 
  - Base On Balls (does not count intentional balls) 
  - Strikes 
  - Balls 
 

 
Inning Stats: 
  - Runs 
  - Hits 
  - Errors 
  - Runners Left on Base 
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Box Scores / Game Summary 
 
To view and print Box Scores and Game Summary: 
  - Select Box Scores from the Statistics Menu 
  - If no game is open, choose a game file (*.GAM) to be analyzed from the Games 
 List Box 
  - Select OK 
  - Select the Print button to print the Box Scores and Game Summary 
  - Select the Export button to export the Box Scores and Game Summary to either an 
 ASCII text file or to an HTML file 
- Select the FTP Button to send the HTML output to the server defined in the 
 program's options.   From the resulting popup menu, select Send HTML Once  to 
 send the file once or select Send HTML Every XX Seconds to have ScoreBook 
 resend the file every XX seconds. 

 

 
 
Printing 
 
To Print Scorecards for a Game: 
  - Select Print from the File Menu 
  - Select Game 
  - Choose a Game file from the Files List 
  - Select the desired Scorecard(s) using the Print Option Radio Buttons 
  - Select the Number of At Bat columns to print per page (Default 9) 
  - If you want the printout to show only those At Bats with Data, clear the Print Fields 
 that don't have data check box 
  - Select the Print Button 
 
Note: If you get insufficient memory error messages while printing a Game, try printing 
the Home & Visitor Scorecards one at a time.  That is, change the Print Options Radio 
Button from Both to Home At Bats, then select Print.  Then select Visitor At Bats, 
then select Print again. 
 
If you still have trouble, try selecting Printer Setup and changing the Orientation to 
Landscape. 
 
To Print Blank Scoresheets: 
  - Select Print from the File Menu 
  - Select Blank Score Sheets 
  - Choose how many columns per page, number of positions, and number of pages from 
 the drop down lists provided 
  - Select the Print Button



 24

PDA Utilities 
 
ScoreBook Companion is an optional program designed to allow the user to input teams 
and score games using a PDA.  There are two versions of ScoreBook Companion, one 
for Palm OS devices, and another for Windows CE-based Pocket PCs. 
 
 

Palm ScoreBook Companion 
The PDA Utilities support the transfer of data to and from a Palm device.  The 
ScoreBook Companion program (ScoreBook.prc) and your desktop game and team 
files (.pdb extension) can be installed via the PDA Utilities.  In addition these utilities 
can be used to import game and team databases transferred from the Palm.  The actual 
transfer of data is accomplished when the user performs a Hot Sync with the Palm 
Device. 
 
To Install the Palm ScoreBook Companion: 
  - Select Palm Install from the PDA Utilities Menu 
  - Select ScoreBook Companion 
 (The user should get a message indicating that ScoreBook Companion should be 
 available after the next Hot Sync) 
  - Perform a Hot Sync with the Palm Device 
 
To Export a Game to a Palm Device: 
  - Select Palm Export from the PDA Utilities Menu 
  - Select Game To Palm... 
  - Choose a Game file created on the PC (*.gam) 
  - Enter a unique name for the Palm Game File to be created (*.pdb) 
 (The user should get a message indicating that the Game should be available after 
 the next Hot Sync) 
  - Perform a Hot Sync with the Palm Device 
 
To Export a Team to a Palm Device: 
  - Select Palm Export from the PDA Utilities Menu 
  - Select Team To Palm... 
  - Choose a Team file created on the PC (*.tem) 
  - Enter a unique name for the Palm Team File to be created (*.pdb) 
 (The user should get a message indicating that the Game should be available after 
 the next Hot Sync) 
  - Perform a Hot Sync with the Palm Device 
 
To Import a Game from a Palm Device: 
  - Perform a Hot Sync with the Palm Device 
  - Select Palm Import from the PDA Utilities Menu 
  - Select Game From Palm... 
  - Choose a Game file (*.pdb) from the Palm User Backup directory 
  - Enter a unique name for the Desktop Game File to be created (*.gam) 
 (The user should get a message indicating a Game file was successfully created from 
 the Palm Database) 
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To Import a Team from a Palm Device: 
  - Perform a Hot Sync with the Palm Device 
  - Select Palm Import from the PDA Utilities Menu 
  - Select Team From Palm... 
  - Choose a Team file (*.pdb) from the Palm User Backup directory 
  - Enter a unique name for the Desktop Team File to be created (*.tem) 
 (The user should get a message indicating a Team file was successfully created from 
 the Palm Database) 
 
 

Pocket PC ScoreBook Companion 
ScoreBook also supports the transfer of data to and from a Pocket PC.  Your desktop 
game and team files can be installed via the PDA Utilities.  In addition these utilities can 
be used to import games and teams created on a Pocket PC. 
 
Important Note:  For the following features to work properly, Active Sync should be set 
as follows to allow for File Synchronization between the Desktop and the Pocket PC: 
  -  Run Active Sync 
  -  Select Options from the Tools Menu 
  -  Select the Sync Options Tab 
  -  Check the Files Checkbox 
 
To Export a Game to a Pocket PC: 
  -  Select Pocket PC Export from the PDA Utilities Menu 
  -  Select Game To Pocket PC... 
  -  Choose a Game file created on the PC (*.gam), then Select Open 
  -  Select Save 
 (ActiceSync should transfer the file to your Pocket PC the next time the device is 
 connected to your PC) 
 
To Export a Team to a Pocket PC: 
  - Select Pocket PC Export from the PDA Utilities Menu 
  - Select Team To Pocket PC... 
  - Choose a Team file created on the PC (*.tem), then Select Open 
  -  Select Save 
 (ActiceSync should transfer the file to your Pocket PC the next time the device is 
 connected to your PC) 
 
To Import a Game from a Pocket PC: 
  - Attach Pocket PC to your PC and allow ActiveSync to Synchronize files 
  - Select Pocket PC Import from the PDA Utilities Menu 
  - Select Game From Pocket PC... 
  - Choose a Game file (*.gam) from the list provided, then Select Open 
  - Enter a name for the Desktop Game File to be created (*.gam), then Select Save 
 
To Import a Team from a Pocket PC: 
  - Attach Pocket PC to your PC and allow ActiveSync to Synchronize files 
  - Select Pocket PC Import from the PDA Utilities Menu 
  - Select Team From Pocket PC... 
  - Choose a Team file (*.tem) from the list provided, then Select Open 
  - Enter a name for the Desktop Team File to be created (*.tem), then Select Save 
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Options 
 
All Display and League Options are selected via the Options Menu. 
 
Display Options 
 
The Prompt for “Hit To” Location option allows the user to select whether or not to 
input where the ball was hit for each At Bat 
 
The Prompt for “Pitch Data” option allows the user to select whether or not to input 
pitch location and speed data for each At Bat 
 
The Use Sound Effects option allows the user to turn sound effects on or off 
 
When Auto Prompt for Next Inning is selected, the user will be prompted to advance 
to the next half-inning each time the number of Outs Per Inning (See League Options 
below) has been reached 
 
In Addition the user may change the default colors for the following: 

  - Lineup 1st Player Background Color 
  - Lineup Highlight Color 
  - Lineup 2nd Player Background Color 
  - Lineup Text Color 
  - Hit To Line Color 
  - Pitch Data Current Ball Color 
  - Pitch Data Strike Ball Color 
  - Pitch Data Not Strike Ball Color 
  - Pitch Data Hit Ball Color 

 
The Browse button can be used to select a different field image path for ScoreBook 
 
The Language drop-down list lets you select the language used in the 8t3rqn8t3rqn 
 
 
League Options 
 
The following items are adjustable by selecting values from the drop-down lists provided 
on the League Options Tab: 
 

  - Strikes Per Out 
  - Balls Per Walk 
  - Outs Per Inning 
  - Innings Per Game (Used in ERA Calculations) 

 
When the Use LL Pitching Rules checkbox is selected, partial innings pitched are 
counted as whole innings. 
 
HTML Options 
 
Allows the user to tailor the following attributes of web pages output by ScoreBook: 
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The Background image name checkbox lets you optionally define an image that will be 
used as the HTML background image.  The name must include the path to the image file 
as it is found on your server. 
 

  - Header Background Color 
  - Primary Row Background Color 
  - Alternate Row Background Color 
  - Font Color 
  - Default Font 
  - Header Font Color 
  - Font Face Name 
  - Font Size 
  - Header Font Size 

 
Server Options 
 
Allows the user to define the server attributes that are to be used when uploading HTML 
files via the FTP functions in the Statistics and Box Scores / Game Summary dialogs.    
These attributes include : 
 

  - Server Name 
  - User Name 
  - Password 
  - Upload Directory  (e.g., web or public_html) 
  - Delay for Timed Uploads in Seconds 

 
When the Use frames when uploading HTML BoxScores checkbox is selected, the 
boxscores will be uploaded in two frames.  The left frame will be the boxscore and the 
right frame will be the game summary. 
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Using FTP Functions to Send Stats and Box Scores 
 
Baseball ScoreBook provides FTP (File Transfer Protocol) functionality such that Box 
Scores with game summary and player statistics can be easily uploaded to a server or 
other machine accessible by the FTP.   You may wish to use this functionality to upload 
real-time game summaries and statistics to be viewed on the World Wide Web while 
scoring your games.   In order to use the FTP functions, you must first define the server 
options by selecting Options : Server Options from the main menu. 
 
From this dialog, fill in all of the fields and select a range between 10 and 300 seconds 
for the 'Delay for Timed Uploads'.    This is the amount of time that ScoreBook will delay 
before sending updated HTML files while scoring a game. 
 
The upload directory should be any write accessible directory on the defined server.    If 
you wish to make the files accessible by the World Wide Web, you should configure the 
'Upload Directory' field for either 'web' or 'public_html' (which ever is used by your 
server).    
 
When scoring games and uploading HTML files, Baseball ScoreBook will generate the 
following file names which will be uploaded to the defined server : 
 
For Statistics, the file will be constructed using the following naming scheme : 
 

[Game File Name]_[TeamName]_[B for batting or P for pitching].HTM 
 
  Example : 
  sample_HuntsvilleHounds_B.HTM for sample.gam, Huntsville Hounds, Batting  
   statistics.    
 
For Box Scores with game summary, the file will be named using the following 
scheme : 
 
  [Game File Name]_BOXSCORE.HTM 
 
  Example : 
  sample_BOXSCORE.HTM for sample.gam 
 
To have ScoreBook automatically upload these HTM files while you are scoring a game, 
simply open the Box Score dialog by selecting Statistics : Box Score ...  and / or  
Statistics dialog by selecting Statistics : Team and Player Stats from the main menu.   
Next, select the 'FTP' button from the dialogs : 
 
And then, Send HTML Every XX Seconds  from the popup menu.   Now, leave the 
dialogs open and ScoreBook will take care of the rest.     If you don't have enough room 
on your screen to display these dialogs, you may minimize them. 
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Using FTP Functions to Send Game and Team files 
 
You can use the built-in FTP functions of Baseball ScoreBook to send a game or team 
file to a server.   To do this, select File : Send from the main menu. 
 
From this dialog, select the type of file (GAME or TEAM) from the drop-down list and 
then the file name from the file list box.   Additionally, fill out all of the Server Options 
including your User Name and Password for accessing the server. 
 
Once you have selected the file you want to send, select the Send button.  As 
ScoreBook communicates with your server, messages will be updated in the FTP Status 
box.   After the transfer is complete, you can either select another file to send or the 
Done button to close this dialog. 
 

 
 
Accessing ScoreBook Home Page 
 
The Fixed It! Baseball ScoreBook Home Page is located at :     
  http://www.FixedIt.com 
 
From our website, you can downloaded the latest version of our software, post and read 
messages on our forum, and obtain customer support. 
 
Additionally, you can learn more about other Fixed It! Sports products including :  
Fixed It! Football ScoreBook, Fixed It! Basketball ScoreBook,  Fixed It! Soccer 
ScoreBook, Fixed It! Golf ScoreBook, and Fixed It! Hockey ScoreBook. 

 
 
Removing the Program 
 
To uninstall Baseball ScoreBook: 
 
  - Select Programs 
  - Select the Fixed It! Software Folder 
  - Select Uninstall Baseball ScoreBook 
 
You may also uninstall Baseball ScoreBook by selecting Control Panel, Add or Remove 
Programs, and Baseball ScoreBook 
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Registration 
 
To receive a fully licensed copy of Fixed It! Baseball ScoreBook, you can purchase 
online or through the mail. 
 

For mail orders: 
 
  -  Select Print from the File Menu. 
  -  Select Registration Form... 
  - Enter your name, mailing address, e-mail address and comments into the dialog 

fields.  If you provide an e-mail address, we will status your order as soon as we 
receive it.  Also, please provide feedback in the Comments field, especially features 
you would like to see implemented in future releases of ScoreBook. 

  -  Select the OK button. 
  -  Make out a check or money order to Fixed It! Software (U.S. Funds only) for either of 
 the following amounts:  
 
(1) Baseball ScoreBook for Windows       $59.95 
(2) Baseball ScoreBook Plus Companion (both Palm and Pocket PC OS)  $89.95 
 

  -  Mail your form and check to: 
 

         Fixed It! Software 
         1648 Taylor Rd. #219 
         Port Orange, FL 32128 

 
- You will receive an e-mail notice once we receive your order and a CD in the mail 
 within 3-5 days after receipt of your payment. 

 

For online sales: 
 
To place a Credit Card Order or Purchase Order, please visit the Fixed It! ScoreBook 
home page :   
             
  http://www.FixedIt.com 
 
From here, you can place your order online securely and receive instant download 
access to the full version.   We also have instructions for placing Purchase Orders via 
FAX. 
 

Registering has the following benefits: 
 
- Full-featured product with no nagware or other shareware limitations 
 (such as Printing games and stats) 

 
- FREE Lifetime Technical Support (via e-mail and website) and Upgrades 

 (via the Registered portion of the Fixed It! ScoreBook website) 


